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OVERVIEW 
This tutorial presents exercises that will assist you in developing a solid understanding of the basic 
functions in STK as well as a brief introduction to some of STK’s more advanced features and functions. 
The tutorial is intended to help you develop a context in which to place the fine details of STK as you 
begin to work with the program and its modules. Use the demo scenarios shipped with STK and the 
tutorial that follows to become familiar with the basic structure of STK as well as its functions and 
features. 

 
Licenses Needed 

This tutorial requires that you be licensed for the STK Professional Edition.  

 

Although this tutorial introduces the user to many of the features available in STK, it addresses only a 
small sampling of STK functionality. For a complete explanation of all STK functions, please consult the 
STK Online Help system or take one of our extensive training classes. 

Creating the STKTutorial Scenario 
 

Note: To ensure that you do not accidentally overwrite your previous work, save 
each scenario in a separate folder and name the folder with the same name as 
the scenario.   

The scenario is the highest-level object in STK; it includes one or more 2D and 3D Graphics 
windows and contains all other STK objects (e.g., satellites, facilities, etc.). This section of the 
tutorial guides you through the process of creating and populating a scenario. 

1. Start STK. 

2. To create a new scenario, click the  (Create a New Scenario) icon in the Welcome to STK! 
window. The STK: New Scenario Wizard will appear. This is a window designed to help 
streamline the process of creating, saving, and organizing scenario files. 

3. Rename the scenario STKTutorial. 

4. You can add a unique description so that you can remember the reason you created this 
scenario. Enter “Learning the basics of STK.” 

5. Set the Analysis Period Start Time to 1 Jul 2007 12:00:00.000 UTCG. 

6. Set the Analysis Period End Time to 2 Jul 2007 12:00:00.000 UTCG. 

7. Click OK. A 2D and 3D Graphics window appears. Also the Insert STK Objects 
window appears. 
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Note: For publication purposes, 2D Graphics colors have been reversed. In most 
instances, the 2D Graphics window is a color-on-black display.   

. 
Tip: To change the size of the 2D or 3D Graphics window, click and hold the 

mouse button on any of the corners and drag the window border. When you 
release the mouse button, the window re-sizes. The aspect ratio of the map 
projection is preserved automatically by STK, by creating blank space in the 
window when its size does not fit the correct ratio. Click the  (2:1 Aspect 
Ratio) button on the 2D Graphics toolbar to resize the window to eliminate 
this blank space.   

 

You are now ready to start building a scenario. 

Setting the STKTutorial Environment 
Before performing any tasks in STK, you need to set parameters that will affect all aspects of 
your scenario as it is built.  

Setting Application Properties 
First, we will set some application parameters for STK. These high-level parameters affect every 
object within the application, regardless of the scenario currently open.  

1. To set parameters for the STK application, click Edit Preferences… on the Insert STK 
Objects window. 

2. In the window that appears, select Save/Load Prefs: 

3. In the Ephemeris frame, verify that Save Vehicle Ephemeris is on and Binary Format is off. 

4. Verify that Save Accesses is disabled. 

5. Verify that Auto Save is on. 

6. Verify that Save Period is set to 300 sec (5 min). 

7. Click OK to apply any changes and to dismiss the Preferences window. 
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Saving the Scenario 
Before proceeding to the next section, save the STKTutorial scenario. 
Select Save from the File menu or click the  (Save) button.  This saves the scenario and all the 
objects you created and defined for the scenario, including the properties that you entered or 
selected. 

Creating Facilities 
Now you are ready to populate the scenario with various objects. Start with facilities such as 
ground stations, launch sites and tracking stations. 

1. Bring up the Insert STK Objects window. If the Insert STK Objects window is not shown, 
click the Insert STK Objects button ( ) on the default toolbar. 

2. Select Facility (  ) in the Scenario Objects field. 

3. Select  Define Properties.  

4. Click Insert… This will bring up the properties for the facility. 

Defining Facilities 

1. Select the Basic – Position page. 

2. On the Position page, ensure that the Type is set to Geodetic. 

3. Set Latitude to 48.0 and Longitude to 55.0.  Leave Altitude at its default setting of 0. 

4. Select the Basic - Description page. 

5. Enter a Short Description, such as "Launch Site." 

6. Enter a Long Description, such as "Launch site in Kazakhstan. Also known as 
Tyuratam." 

7. Click OK. 

8. Select the Facility in the Object Browser. 

9. Click F2 to rename the facility to Baikonur. 
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10. Use the procedures described above to add the facilities listed in the following table (Don't 
worry about the Long Description).  

Table 1.  Settings for Perth & Wallops facilities 

Name Latitude Longitude Altitude Short Description 

Perth -31.0 116.0 0.0 Australian 
Tracking Station  

Wallops 37.8602 -75.5095 -0.012787
8 

NASA Launch 
Site/Tracking 
Station 

11. When you finish defining each facility, click OK.  

The Facility Database 
Now you will use the Facility Database to add two more facilities to the scenario. 

1. Bring up the STK Insert STK Objects window.  

2. Select Facility (  ) in the Scenario Objects field. 

3. Select  Select From Facility Database in the Select A Method field. 

4. Click Insert… This will bring up the Facility Database. 

5. Click Advanced… 

6. Turn on the Network option and select NASA DSN as the Network. 

7. Click OK. 

8. Scroll to the bottom of the list in the Facility Database Search Results window and 
highlight Santiago and WhiteSands. (Select one of them, then hold down the CTRL key 
and click on the other.) 
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9. Click Insert to add the facilities. 

10. Click Close on the Facility Database. 

11. Open the Basic Properties window for the Santiago facility and select Description. 

12. Note that the Long Description field includes position and other data about the facility.  

Note: When objects are inserted using any of the databases shipped with STK, 
descriptions are automatically generated for the objects.   

 

13. Click OK or Cancel. 

14. Close the Insert STK Object window. 

Setting 2D Graphics Attributes 
A variety of 2D graphics properties can be set for a facility in STK. 

1. Select a facility whose color you would like to change—e.g. because it does not show up 
clearly against the background. 

2. Open the facility’s Properties by clicking the Properties button ( ) in the Object Browser 
toolbar. 

3. Select the 2D Graphics - Attributes page.  

4. Select the desired color. 

5. Click OK. 

6. Repeat steps 1-2 for any other facilities whose color you wish to change. 
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Creating a Target 

The target for this exercise is a glacier field over North America. You are going to insert the 
target using the Object Catalog. 

1. Insert a target (  ) from the Object Catalog (  ). 

2. Change the target's name to Iceberg. 

3. Open the Iceberg’s Properties Browser.  

4. On the Position page, verify that the Type is set to “Geodetic”. 

5. Enter a Latitude of 74.91 and a Longitude of -74.5. 

6. Open the Description page and enter a short description, such as "Only the tip of the 
Iceberg." 

7. Click OK. 

Creating a Ship 

STK objects include three types of great arc vehicles—aircraft, ships and ground vehicles. In this 
exercise you will create a ship. 

1. Insert a ship (  ) from the Object Catalog, and change its name to Cruise. 

2. Open the Cruise’s Properties Browser. 

3. On the Route page, ensure the Start Time is set to your default scenario start time. 

4. Ensure the Propagator is set to GreatArc. 

5. Ensure the Route Calculation Method is set to Smooth Rate.  

Note: Once you enter a Rate and Start Time for a great arc vehicle, STK 
automatically calculates the Stop Time and displays it in a read-only field.   

6. Enter the waypoint values shown in the following table for the ship in the waypoints table. 
To insert a line of data, click the Insert Point button. 
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Table 2. Ship waypoints 

Latitude Longitude Altitude Speed 

44.1 deg -8.5 deg 0.0 km .015  km/sec 

51.0 deg -26.6 deg 0.0 km .015 km/sec 

52.1 deg -40.1 deg 0.0 km .015 km/sec 

60.2 deg -55.0 deg 0.0 km .015 km/sec 

68.2 deg -65.0 deg 0.0 km .015 km/sec 

72.5 deg -70.1 deg 0.0 km .015 km/sec 

74.9 deg -74.5 deg 0.0 km .015 km/sec 

7. Select the Basic - Attitude page. 

8. Ensure ECF velocity alignment with radial constraint is selected. 

9. Open the 2D Graphics - Route page. 

10. Make certain that Show Turn Markers is turned on, and click OK. 

11. In the Animation toolbar, click the  (Reset) button, and look at the 2D Graphics window. 

 

Displaying and Modifying a Model 
All objects in STK are represented in the 3D Graphics window by models. There are default 
models for standard objects, as well as models designated for specific objects that you might 
import into a scenario, such as the Cruise Liner, which we will be examining in this exercise. For 
any object in STK, you can change the model to something other than what is initially assigned 
to it. 

1. Open the Properties Browser for the Cruise. 
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2. Select 3D Graphics - Model.  

3. In the Model frame, verify that Show is enabled, and that Scale is set to 0.0. 

4. In the Detail Thresholds frame, disable Use. 

5. To change the model, click the ellipsis button  in the Model File field.  

6. Browse to the model cruise_liner.mdl. 

7. Click Open. 

8. Click OK. 

9. Select the 3D Graphics window 

10. Click View From/To ( ) in the 3D Graphics window toolbar. 

11. In the View From field, select the Cruise. The Cruise Liner will also become highlighted in the 
View To field. 

12. Click OK. 

13. The Cruise Liner should now appear front and center in the 3D Graphics window.  

 

Creating Satellites 

Now you will add a few satellites to the scenario, namely an Earth Resources Satellite (ERS1), a 
Space Shuttle and two Tracking & Data Relay (TDRS) satellites. 

Using the Orbit Wizard 
The STK Orbit Wizard provides a quick and easy way to generate a variety of frequently used 
satellite orbit patterns. 
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1. Click the Insert Object (  ) button to bring up the Insert STK Object window. 

2. Select Satellite (  ) in the Scenario Object field. 

3. Select Orbit Wizard ( ) in the Select A Method field. 

4. Click Insert… to launch the Orbit Wizard. 

5. Select Geosynchronous as the Type. 

6. Set the Satellite Name to TDRS. 

7. Ensure the Subsatellite point is set to -100 deg. 

8. Ensure the Use Scenario Time Period option is on. 

9. Click OK on the Orbit Wizard. 

Using the Satellite Database 
STK is shipped with a rich and extensive set of satellite databases, together with an interface to 
make it easy to find and propagate the satellite of interest. Here you will use the Satellite Database 
to define a second TDRS satellite for your scenario. 

1. Bring up the Insert STK Object window. 

2. Select Satellite (  ) in the Scenario Object field. 

3. Select Select from Database in the Select A Method field. 

4. Click Insert… 

You can quickly generate a list of all TDRS satellites in the database. To quickly generate that 
list of TDRS satellites, you can use an asterisk (*) as a wild card in the Common Name field. 
Let’s try this.  

5. Turn On the Common Name field.  

6. Type TDRS* in the text field. 

7. Turn Off the SSC Number option. 

8. Click Search to perform a search for all active TDRS satellites. 

9. In the search results window, select TDRS 3. 

10. Click the Time Period… button. 

11. Ensure the Use Scenario Time Period is selected. 
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12. Click OK. 

13. Click Insert Satellite. 

14. For this step you need an active Internet Connection. If you do not have an internet connection, you need 
to click the Advanced… button in the Satellite Database. Turn On Use Default Satellite Database. Click 
OK. This will allow you to enter the TDRS_3 satellite into the scenario.  

15. Click Close in the Satellite Database window. 

16. Close the Insert STK Object Tool. 

17. Rename the satellite to TDRS_3. 

If the 2D Graphics window does not show your new TDRS satellites, click the  (Reset) button. 

 

 
Note: The ground tracks for both satellites display in the 2D Graphics window as 

specks since they are in geostationary orbit.   

Defining Orbital Parameters 
A great variety of satellite orbits can be propagated using the Orbit Wizard and Satellite Database. In 
addition, STK allows you to define any satellite orbit precisely using a number of propagators 
and force models. You will now add two satellites to the scenario using the J4 Perturbation 
propagator, which accounts for secular variations in the orbit elements due to Earth oblateness. 

1. Create a new satellite using Insert STK Objects. 

2. Select Satellite (  ) in the Scenario Objects field. 
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3. Select Define Properties in the Select A Method field. 

4. Click Insert… to launch the Properties page. 

5. Select the Basic – Orbit page. 

6. Select J4 Perturbation as the Propagator. 

7. Enter the orbital parameters for ERS1, found in the following table. Use the down-pointing 
arrow  to change the default RAAN (Right Ascension of the Ascending Node) option to Lon 
Ascn Node (Longitude of Ascending Node) before entering the values listed in the table.  

Table 3.  Orbital elements for ERS1 

Orbital Element Setting 

Start Time Use Scenario Analysis Period 

Stop Time Use Scenario Analysis Period 

Step Size 60.00 

Orbit Epoch Scenario Default Start Time 

Coordinate Type Classical 

Coordinate System J2000 

Semimajor Axis 7163.14 km 

Eccentricity 0.0 

Inclination 98.50 deg 

Argument of Perigee 0.0 deg 

Lon Ascn Node 99.38 deg 

True Anomaly 0.0 deg 

8. When you finish, click Apply, and then click the  (Reset) button.  

9. Rename your satellite ERS1.  

10. Your 2D Graphics window should look like this: 



15 

 

11. Open the satellite’s 2D Graphics - Pass page.  

12. To display only the descending side of the orbit, change Visible Sides from Both to Descending 
and click Apply.  

 

13. Observe the change in the 2D Graphics window. 

14. When you finish, return the Visible Sides option to Both and click OK.  

15. Bring up the Insert STK Objects window. 

16. Select Satellite (  ) in the Scenario Object field. 

17. Select Define Properties in the Select A Method field. 

18. Click Insert… to launch the Properties page. 

19. On the Orbit page for the Shuttle, select J4Perturbation as the Propagator. 
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20. Use the down-pointing arrow to change the default setting of Semimajor Axis to Apogee Altitude.  
The default Eccentricity option will automatically change to Perigee Altitude. 

21. Use the down-pointing arrow to change the default setting of RAAN to Long Of Ascending Node. 

22. Enter the orbital elements for the Shuttle as given in the following table. 

Table 4.  Orbital elements for the Shuttle 

Orbital Element Setting 

Start Time Use Scenario Analysis Period 

Stop Time Use Scenario Analysis Period 

Step Size 60.0 sec 

Orbit Epoch Default Start Time 

Coordinate Type Classical 

Coordinate System J2000 

Apogee Altitude 370.4 km 

Perigee Altitude 370.4 km 

Inclination 28.5 deg 

Argument of Perigee 0.0 deg 

Long of Ascending Node -151.0 deg 

True Anomaly 0.0 deg 

23. When you finish, click OK.  

24. Rename the new satellite Shuttle. 

25. Open the Properties Browser for the Shuttle. 

26. Select 3D Graphics - Model.  

27. In the Model frame, verify that Show is enabled, and that Scale is set to 0.0. 

28. In the Detail Thresholds frame, disable Use. 

29. To change the model, click the ellipsis button  in the Model File field.  

30. Browse to the model shuttle-05.mdl. 

31. Click Open. 

32. Click OK. 

33. Select the 3D Graphics window 
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34. Click View From/To ( ) in the 3D Graphics window toolbar. 

35. In the View From field, select the Shuttle. The Shuttle will also become highlighted in the 
View To field. 

36. Click OK. 

2D Graphics Properties 
You have already become acquainted with the Pass page of the satellite’s 2D Graphics properties. 
Now you will use the Shuttle to experiment with further graphics features. 

1. Open the Properties Browser for the Shuttle, and select the 2D Graphics - Attributes page.  

2. Change the Line Style to dashed and the Marker Style to Plus, and click Apply. 

3. Now select the 2D Graphics - Contours page.  

4. Turn On the Show option for Elevation Contours. 

5. In the Level Attributes area, click Remove All to remove any existing entries from the Level list. 

6. In the Level Adding area, make sure the Add Method is set to Start, Stop, Step, then enter 0, 50 and 
10 for the Start, Stop and Step values, and click Add. 

7. In the Level list, highlight the first level (0.00) and turn OFF the ShowLabel field. Change the 
Color and/or Line Style and/or Line Width if you wish. 

8. Repeat step 7 for the remaining levels. 

9. Click OK. 

10. To see the contour levels, click the  (Reset) button.  Zooming in will provide a better view. 

 



18  

11. When you finish, zoom out to a normal 2D Graphics view. 

 

Note: To zoom in on a region in the 2D Graphics window, click the  (Zoom In) 
button in the graphics window, place the mouse pointer in one corner of the 
region of interest, hold down the left mouse button, and drag the pointer to the 
opposite corner of the selected region. You can do this repeatedly. To restore 
the full 2D Graphics window view, click the  (Zoom Out) button as often as 
necessary.   

Map Projections 
In this section of the Tutorial you will create a second 2D Graphics window and become 
acquainted with some of the map projections available with STK. 

Creating a New 2D Graphics View 

1. From the View menu, select Duplicate 2D Graphics Window  2D Graphics 1 – Earth. 

2. When the second 2D Graphics window appears, move it so that you can see both 2D 
Graphics windows at once. 

Note: It may be helpful to float one of the 2D Graphics windows so that you can 
move it out of the workspace. Simply right-click on the window’s title bar, 
select Floating from the choices presented, hold down the CTRL key, and drag 
the window to the desired location.   

3. Select the new 2D Graphics window, and click the  button in the 2D Graphics window to 
launch its 2D Graphics properties window. 

4. Open the Projection page. 

5. In the Projection Format frame, change the Type to Perspective. 

6. Set the Display Coordinate Frame to ECI. 

7. In the Center field, enter Latitude of -3.418 deg. 

8. Enter the Longitude of 54.99 deg.  

9. Enter 35000 km as the Altitude. 

10. Click OK to view the changes in the 2D Graphics window. If the satellite orbits do not 
appear, click the  (Reset) button. 
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Sampling Map Projections 

1. Select the original 2D Graphics window (2D Graphics - Earth), and click the  button to 
display its properties. 

2. Move the 2D Graphics properties window into a position where you can see it and the 2D 
Graphics window simultaneously. 

3. Open the Projection page and open the Type list in the Projection Format frame. 

4. Select any other projection (such as the Sinusoidal projection shown below), and click Apply to 
see it in the 2D Graphics window. 

 

5. Browse through the available projections by repeating Step 4 for each projection listed in the 
dropdown list. 

6. When you finish, restore the first 2D Graphics window to Equidistant Cylindrical, and click OK 
to dismiss the 2D Graphics properties window. 
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Adding an Area Target  

Area targets are used to define geographical regions of interest on the ground. Let’s assume that 
the Cruise ship has run into the Iceberg. You will now create an area target that defines the 
search area for survivors. 

1. Insert an area target (  ) from the Object Catalog, and name it SearchArea. 

2. Launch the area target’s Properties Browser, and open the 2D Graphics - Attributes page. 

3.  Set the Marker Style to None. 

4. Turn Off the Inherit from Scenario, Show Label and Show Centroid options.  

5. Open the Basic - Boundary page. 

6. Click the Add button to insert a boundary point. Double-click the field under Latitude and 
enter the value 78.4399. Similarly, double-click the field under Longitude and enter a value 
of –77.6125. 

7. Repeat step 6 until you have entered all of the boundary points in the following table: 

Table 5.  Area target boundary points 

Latitude Longitude 

77.7879 -71.1578 

74.5279 -69.0714 

71.6591 -69.1316 

70.0291 -70.8318 

71.9851 -76.3086 

8. Click Apply when done. 

9. Now open the Basic - Centroid page. 

10. Turn off the Auto Compute Centroid option. 

11. Set the Position Type to Spherical. 

12. Enter 74.9533 as the Latitude, -74.5482 as the Longitude, and 6358.186790 as the 
Radius.  

13. Click OK. 

14. Zoom the 2D Graphics window in on the region around the area target; then, when you are 
finished, zoom out again. 
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Using the 3D Object Editor 
Facilities, area targets, and great arc vehicles can have their boundaries or routes edited directly 
within the 3D Graphics window using the 3D Object Editor. This exercise explores the basics of 
using the 3D Object Editor. 

1. In the View menu, select the Toolbars  3D Object Editing toolbar. 

2. Select the 3D Graphics window. 

3. Click Home View  on the 3D Graphics Toolbar to set your view to the default position. 

Let’s zoom in on the region around the area target in the 3D Graphics window. 

4. Click and hold the left mouse button, then move your mouse around in the 3D Graphics 
window to rotate the globe. 

5. Click and hold the right mouse button, then move your mouse forward and backward to 
zoom in and out.  

6. Now Zoom In on the region around the area target. 

7. In the 3D Object Editing toolbar, select Area Target/SearchArea from the drop-down menu. 

8. Click Object Edit Start/Accept  to begin editing the SearchArea area target in the 3D 
Graphics window. The boundary points of the SearchArea area target are now highlighted in 
the 3D Graphics window. 

9. By clicking and dragging with the mouse, expand the SearchArea area target’s boundaries to 
encompass a larger area. Notice that while editing the object, the usual mouse controls for 
manipulating the view in the 3D Graphics window function normally. 
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10. Click Object Edit Start/Accept  to apply the changes. The area target now has new 
boundaries. 

 

Working with the 3D Graphics Toolbar – Managing Views 
In this exercise, you will learn to establish custom views that will be more useful or appealing than the 
default view. The default view in the 3D Graphics window, called the Home View, is an Earth-
centered inertial position and direction. You can change the Home View and add other views in the 
3D Graphics window using the 3D Graphics Toolbar. The ability to change the camera position and 
the view direction or camera reference point can be very helpful in analyzing a scenario. When 
you create and store a view, the view is a part of the scenario and can be utilized in any number 
of 3D Graphics windows that you open within the scenario. The following steps will guide you 
through the basics of setting and storing views in the 3D Graphics window. 

1. Click Home View  on the 3D Graphics Toolbar to set your view to the default position. 
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2. Click View From/To   on the 3D Graphics Toolbar. 

3. In the Reference Frame section, select Earth Fixed Axes and click OK. 

4. In the 3D Graphics window, rotate the view so that the White Sands facility is roughly 
centered. 

5. Click Stored Views  in the 3D Graphics window. 

6. Click New to add the current view to the list of stored views. 

7. Double-click the new view and rename it “Fixed Axes”. 

8. Click OK. 

9. Animate the scenario again. Notice that this time the camera position remains fixed on the 
White Sands facility, revolving in sync with the Earth. Using this view we can observe the 
impact of our scenario on the White Sands facility for the entire period. 

10. Reset the animation. 

11. Click View From/To   on the 3D Graphics Toolbar. 

12. In the View From field, select the ERS1 satellite. The ERS1 satellite will also become 
highlighted in the View To field. Click OK. 

13. Manipulate the view in the 3D Graphics window so that the surface of the Earth becomes 
visible beneath the ERS1 satellite. 

14. Click Stored Views  on the 3D Graphics Toolbar. 

15. Click New to add the current view to the list of stored views. 

16. Double-click the new view and rename it “ERS1”, then click OK. 

17. Animate the scenario again. Notice that this time the view follows the ERS1 satellite as it 
orbits the Earth. 

18. Reset the animation. 

19. Use the Stored Views  drop down to cycle through your images. 

20. When you are finished cycling through the stored views, click Home View . 
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21. You can also change the view perspective by holding the shift key and double-clicking on an 
object on the 3D Graphics window. This will have the same effect as setting the view to and 
from the object by using the View From/To button. 

22. Other important 3D Graphics Toolbar features include: 

• Viewpoint Control buttons – Finer , Coarser , and Toggle . The Finer 
and Coarser Viewpoint Control buttons adjust mouse sensitivity from the default, 
while the Toggle Viewpoint Control button resets mouse sensitivity to the default. 

• View Pilot – The View Pilot button  launches a small control panel that allows 
you to make small, incremental adjustments to the view. If this option is not on 

your 3D Graphics window toolbar, click the Toolbar Options drop down ( ). 
Select Add or Remove buttons  3D Graphics. You will see the View Pilot option.  

• Camera Control –The Camera Control button  is an advanced animation feature that 
is not covered in this tutorial. 

Calculating Access 

Now you will calculate access from the ERS1 satellite to the area target to determine whether the 
satellite can view any of the wreckage and help in the search efforts. 

1. In the Object Browser, highlight ERS1, right-click the mouse, and select Access. 

2. When the Access window appears, select SearchArea in the Associated Objects list and click 
Compute. Portions of the satellite's ground track are highlighted in the 2D Graphics window 
to indicate periods of access to the area target. 

 

3. Now click Access… in the Reports area to view an Access Summary Report. As you can see, 
there are several periods of access. 
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4. Close the report. 

5. In the Access window, click the Remove Access button, and then click Close.  

Working with Sensors 
In this exercise you will first attach sensors to a satellite and experiment with sensor pointing 
types. Then you will attach a sensor to a ground facility and limit its visibility to objects a certain 
distance above the horizon. 

Defining and Pointing Sensors 

1. With the ERS1 satellite selected in the Object Browser, insert a sensor (  ) from the Object 
Catalog. Name the new sensor Horizon. 

2. Launch the sensor’s Properties Browser, and open the Definition page. 

3. Make sure the Sensor Type is set to Simple Conic and the Cone Angle is 90 deg. 

4. Select the Basic - Pointing page of the sensor’s properties.  

5. You want to point the sensor straight down relative to the ERS1 satellite. To do this, verify 
that the Pointing Type is set to Fixed and Elevation is set to 90 deg.  

6. Click OK. 

7. Unclutter the 2D Graphics window a bit by removing the Shuttle's contour graphics. Open 
the 2D Graphics - Contours page for the Shuttle, turn off the Show option for Elevation Contours, 
and click OK. 

8. In the first 2D Graphics window (2D Graphics - Earth), click the  (Reset) button, and then 
click the  (Animate Forward) button. Note the graphics representing the Horizon sensor's 
field of view (shown here zoomed). 
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9. Stop the animation by clicking   (Reset) or  (Pause). 

10. Launch the sensor’s Properties Browser, and open the Definition page. Change the Cone Angle 
to 45 deg. 

11. Open the 3D Graphics – Attributes page and enable Translucent Lines. 

12. Select 3D Graphics - Pulse.  

13. In the Parameters frame, turn on the Show option.  

14. Ensure the Amplitude is set to 0.5. 

15. Set the Pulse Length to 2000 km. 

16. Set the Frequency value to Slow. 

17. Set the Value to 0.083 Hz. 

18. Click Ok. 

19. Click View From/To   on the 3D Graphics Toolbar. 

20. In the View From field, select the ERS1 satellite. The ERS1 satellite will also become 
highlighted in the View To field. Click OK. 

21. In the 3D Graphics window, adjust the view so that you can get a good look at the satellite in 
reference to the Earth’s surface, such as the following image depicts. 

22. Animate the scenario and watch the sensor’s projection as the satellite travels along its orbit. 

 

23. Reset the animation. 
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24. Bring up Horizon’s Properties. 

25. Select the 3D Graphics – Pulse page. 

26. Disable Show in the Parameters section. 

27. Open the Definition page. 

28. Set the Cone Angle to 90 deg. 

29. Click OK to dismiss Horizon’s Properties. 

30. Click Home View  on the 3D Graphics Toolbar to set your view to the default position. 

31. Add another sensor to the ERS1 satellite and name it Downlink. 

32. Open the new sensor's Definition page.   

33. Select Half-Power as the Sensor Type 

34. Set the Frequency to 0.85 GHz and the dish Diameter to 1.0 meter. STK computes the half-
angle for you. 

35. Open the Basic - Pointing page. 

36. Change the Pointing Type to Targeted and the Boresight Type to Tracking.  

37. Select the Baikonur facility in the Available Targets list. 

38. Move ( ) Baikonur to the Assigned Targets list. 

39. Repeat Step 15 for each facility until all the facilities appear in the Assigned Targets list. 

40. Click OK.  

41. Animate the scenario and let the animation run until the ERS1 satellite moves over the 
Santiago facility (shown here zoomed).  
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42. Click the  (Reset) button to stop the animation. 

Limiting a Sensor's Visibility 

Now you will attach sensors to a couple of ground facilities and limit their visibility. 

1. Attach a sensor to the Wallops facility and name it FiveDegElev 

2. Open the new sensor's Basic - Definition page. 

3. Set the Sensor Type to Complex Conic. 

4. Set the Inner Half Angle value to 0 deg 

5. Set the Outer Half Angle value to 85 deg. 

6. Set the Minimum Clock Angle to 0 deg. 

7. Set and the Maximum Clock Angle to 360 deg. 

8. Open the Basic - Pointing page, and make sure that the Pointing Type is set to Fixed and that 
Elevation is set to 90 deg. 

9. Open the 2D Graphics Projection page.  

10. Set the Maximum Altitude to 785.248 km and the Step Count to 1. 

11. Click OK.  
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12. You can reuse the new sensor. Highlight the FiveDegElev sensor in the Object Browser and 
select Copy from the Edit menu.  

13. Now highlight the WhiteSands facility in the Object Browser window and select Paste from 
the Edit menu. 

14. Open the 2D Graphics - Attributes page for the new sensor. 

15. Set the Color to the same color of the WhiteSands facility. This will ensure the fields of view 
of the sensors attached to the WhiteSands and Wallops facilities are more clearly 
distinguishable. 

16. Click OK. 

 

17. Click the  (Reset) button if necessary to display the new color. 
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Static & Dynamic Display of Data 
The reporting and graphing capabilities of STK make it easy to display and analyze data 
developed during a scenario. Also, data that changes over the scenario's time period can be 
displayed dynamically in the course of animation. 

Reports & Graphs 
This exercise illustrates one of the many standard report and graph options that are shipped with 
STK.     
               

Note: In addition to standard report and graph styles, STK makes it easy to create 
custom reports and graphs to suit your particular analytical or operational 
needs.   

1. Highlight the ERS1 satellite in the Object Browser, right-click the mouse, and select 
the Report & Graph Manager. 

2. Select Satellite as the Object Type. 

3. Select ESR1. 

4. Turn Off Show Graphs. 

5. Select Solar AER from the Styles list. 

6. Click Generate. 

7. A report is generated, showing the azimuth, elevation and range of the Sun with respect to 
the ERS1 satellite at one-minute intervals throughout the satellite's time period. 

8. Close the report, but do not close the Report & Graph Manager. 

9. Turn Off Show Reports. 

10. Turn On Show Graphs. 

11. Select Solar AER in the Styles window.  

12. Click Generate. 

13. The data that was previously presented in a report is now displayed in graph form. 

14. To change the color and/or other properties of any of the graph elements, right-click on a 
graph element. 

15. When the Report & Graph context menu appears, select Customization Dialog.  

16. In the Customization Dialog window, make any desired changes to Color, Style or any other 
graph property. 
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17. Click OK to dismiss the Customization Dialog window. 

18. Close the Report & Graph Manager. 

Dynamic Displays & Strip Charts 
STK provides two ways to display data dynamically while a scenario is animating: a dynamic 
display of report-style data, or a strip chart presenting data in graph style. 

1. Open the Shuttle Properties. 

2. Select 3D Graphics – Data Display. 

3. In the Data Display table, turn On the Show option for LLA Position. 

4. Click OK. 

5. Select the 3D Graphics window 

6. Click View From/To ( ) in the 3D Graphics window toolbar. 

7. In the View From field, select the Shuttle. The Shuttle will also become highlighted in the 
View To field. 

8. Click OK. 

9. A dynamic display appears, with entries for time, latitude, longitude, altitude and 
corresponding rate data. 

10. Animate the scenario. The Shuttle's positional and rate values will change as the animation 
progresses.   

11. Pause the animation when the Shuttle is at or near its northernmost position in the 3D 
Graphics window. The displayed value for latitude should be in the vicinity of 28.5 deg. This 
corresponds to the Inclination that was set for the Shuttle when you defined its Orbit 
properties. 
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12. Click the  (Reset) button. 

13. Bring up the Report & Graph Manager. 

14. Select Satellite as the Object Type.  

15. Select Shuttle. 

16. Ensure the Show Reports option is turned off. 

17. Select Solar AER in the Styles Field. 

18. Turn On Dynamic Display/Strip Chart. 

19. Click Generate. 

20. Position the strip chart window so that you can see it and the first 2D Graphics window 
simultaneously and animate the scenario.  

 

Note: Once the animation starts, graph elements will begin to appear on the graph. 
These graph elements can be modified by using the same procedure as for the 
graphs in the preceding section.   

 

21. The strip chart shows azimuth, elevation and range information from the satellite to the Sun.  
Note that the range (distance) varies over a span of about 11500 km, representing the 
difference between the positions in its orbit nearest to and most distant from the Sun. 

22. Click the  (Reset) button. 

23. Close the strip chart. 

24. Click Close to dismiss the Report & Graph Manager window. 
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Setting Constraints 
In this section you will experiment with just two of the many ways in which STK allows you to 
constrain objects and thereby refine your analysis. In both cases you will impose constraints on 
the Horizon sensor attached to the ERS1 satellite. 

1. Highlight the Horizon sensor (attached to the ERS1 satellite) in the STK Object 
Browser, right-click the mouse, and select Access Tool. 

2. Select the Baikonur facility in the Associated Objects window, and click Compute.  

Note: Do not dismiss the Access window. 

 

If you view the 2D Graphics window, you will see the ground track of the ERS1 satellite has been highlighted 
to indicate periods of access between the ERS1 satellite and the Baikonur facility. 

 

3. Now, with the Horizon sensor still highlighted in the Object Browser, launch the sensor’s 
Properties Browser, and select the Constraints - Sun page. 

4. Turn on the Min(imum) option for Sun Elevation Angle, and set the value to 10 deg. 

5. Ensure you have the 2D Graphics window in view so you can see the change immediately. 

6. Click Apply, and note the change in access graphics in the 2D Graphics window. 
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7. Experiment with other values for Sun elevation angle, such as 0 deg, 5 deg, 15 deg and 20 
deg, clicking Apply each time to see the results. 

8. Turn off the Min(imum) option for Sun Elevation Angle, and then open the Constraints - 
Basic page. 

9. Turn on the Max(imum) option for Range, and set the value to 2000 km. 

10. Click Apply, and observe the impact on access graphics in the 2D Graphics window. 

 

11. Experiment with other values for maximum range, such as 1500 km, 1000 km and 500 km, 
clicking Apply each time to see the results. 

12. When you are finished, turn off the Max(imum) option for Range, and click OK to dismiss the 
Properties Browser. 

13. Click the Remove Access button in the Access window, and then click Close to dismiss the 
window. 
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Creating a Walker Constellation 
Finally, you will become acquainted with a tool that allows you quickly to define and propagate 
a constellation of systematically spaced satellites with circular orbits having the same inclination 
and period. We will use the ERS1 satellite as a "seed" to generate the constellation. 

1. Select the ERS1 satellite in the Object Browser window, launch its Properties Browser.  

2. Open the Basic - Orbit page. 

3. Change the Stop Time for the satellite to default start time + six (6) hours. 

4. Click OK. 

5. With the ERS1 satellite still highlighted, right-click the mouse and select Satellite  
Walker… 

6. In the window that appears, make certain that Delta is selected as the Type.  

7. Set Number of Planes to 2.  

8. Set Number of Sat(ellite)s per Plane to 3. 

9. Set the Inter Plane Spacing to 1. 

10. Ensure that RAAN Spread is set to 360 deg.  

11. Ensure the Color by Plane option is turned on. 

12. Uncheck Create unique names for sub-objects. 

13. Click Create Walker. 

 

14. Six new satellites appear in the Object Browser, each with an automatically generated name 
based on the name of the seed satellite. Each of the newly created satellites has two sensors 
with the same properties as those of the sensors attached to the seed satellite. 
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15. Close the Walker Tool dialog. 

16. Click the  (Reset) button, and animate the scenario. 

 

17. Observe how the (targeted) Downlink sensor pattern appears in the 2D Graphics window as 
each satellite passes near a facility. 

18. Click the  (Reset) button. 

Conclusion 
This concludes the tutorial. But we barely scraped the surface. As you undoubtedly noticed while 
working through these exercises, for each properties page you opened, for each menu item you 
selected, for each option you tried out, and for each tool you used, there were many dozens we 
had to skip over. 
 
So, why not take another voyage through the tutorial, this time exploring some detours and 
browsing through some of the many properties pages, menus and tools you find along the way? 
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